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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published March 2021. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
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Overview 
 

Welcome to Deltek Costpoint Cloud 8.1.1 Release Notes. These release notes contain a summary of the 
following: 

 Enhancements 

 Software Issues Resolved 

Note that the version numbers above (for example, 8.1.1) refer to the Costpoint Maintenance Release 
(MR) upon which this document is based are for reference only.  
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Enhancements 
This section includes summaries of the enhancements made to existing features in this release. 

Regulatory 

State 

2022 SUTA Wage Base 
This Costpoint release adds tax table records effective 01/01/2022 for states where the unemployment-
taxable wage base has been updated for tax year 2022. 

Iowa 

The SUTA limit for 2022 is $34,800. 

Montana 

The SUTA limit for 2022 is $38,100. 

Nevada 

The SUTA limit for 2022 is $36,600. 

Washington 

The SUTA limit for 2022 is $62,500. 

Florida Reemployment Tax Electronic Filing Software ID Update 
The EDI/XML Development Team of Florida Department of Revenue provided a new production Software 
ID for Deltek, Inc (Costpoint). The Create Quarterly SUTA Tax File screen now uses the new Software ID 
in the generated XML file for Florida. 

To support the update, Costpoint adds a new State SUTA Electronic File Software Information 
(S_SUTA_SOFTWARE_INFO) database table, which stores the software developer information per state. 

The following screens were updated for this enhancement: 

 Create Quarterly SUTA Tax File (PRPSMM) 

 Print Data Dictionary Report (SYRDD) 

Ohio Tax Table Updates 
Ohio’s withholding methods were revised effective September 1 to incorporate lowered income tax rates. 
The new tables take into consideration the income tax rate reductions that went into effect when House 
Bill 110 (134th General Assembly) was signed into law on July 1, 2021. 

To support the updates to the Optional Computer Method, this release adds new tax table records 
effective 09/01/2021 on the following screens: 

 Manage State Taxes 

 Manage State Standard Deductions 

 Manage State Tax Withholding Adjustments 

 Manage State Tax Tables 
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People 

Validations for Labor Locations, GLCs, Workers’ Compensation Codes, and Pay 
Types Used in Time and Expense 
Multiple screens in Costpoint now provide new validations that prevent you from deleting the following 
codes if they are being used in Deltek Time and Expense transactions: 

 Labor Locations 

 General Labor Categories (GLC) 

 Workers’ Compensation Codes 

 Pay Types 

This new functionality applies you if you use a system where Costpoint is co-deployed with Deltek Time 
and Expense. 

Manage Labor Locations/Locals (LDMLLOC) 
The screen now restricts the deletion of a labor location if: 

 A Time and Expense transaction uses the labor location that you want to delete. 

 You use a system where Costpoint is co-deployed with Deltek Time and Expense. 

An error displays if you attempt to delete a labor location that also exists in any of the following tables: 

 TS_LINE (UDT03_ID) 

 EXP_RPT_EXPENSE_CHARGE (UDT03_ID) 

 EXP_AUTH_EXPENSE_CHARGE (UDT03_ID) 

If the labor location is not found in any of the preceding tables but is found in the 
CHARGE_BRANCH_CHARGE (DFLT_UDT03_ID) table, the screen displays a warning message. If you 
continue with the labor location deletion, the system will also delete the CHARGE_BRANCH_CHARGE 
records that include the selected labor location. 

Manage General Labor Categories (LDMGLC) 
The screen now restricts the deletion of a GLC if: 

 A Time and Expense transaction uses the GLC that you want to delete. 

 You use a system where Costpoint is co-deployed with Deltek Time and Expense. 

An error displays if you attempt to delete a GLC that also exists in any of the following tables: 

 TS_LINE (UDT06_ID and UDT06_CP_COMPANY_CD) 

 EXP_RPT_EXPENSE_CHARGE (UDT06_ID and UDT06_CP_COMPANY_CD) 

 EXP_AUTH_EXPENSE_CHARGE (UDT06_ID and UDT06_CP_COMPANY_CD) 

If the GLC is not found in any of the preceding tables but is found in the CHARGE_BRANCH_CHARGE 
(DFLT_UDT06_ID) table, the screen displays a warning message. If you continue with the GLC deletion, 
the system will also delete the CHARGE_BRANCH_CHARGE records that include the selected GLC. 

Manage Workers’ Compensation Codes (LDMWC) 
The screen now restricts the deletion of a Workers’ Compensation Code if: 
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 A Time and Expense transaction uses the Workers’ Compensation Code that you want to delete. 

 You use a system where Costpoint is co-deployed with Deltek Time and Expense. 

An error displays if you attempt to delete a Workers’ Compensation Code that also exists in any of the 
following Deltek Time and Expense tables: 

 TS_LINE (UDT08_ID) 

 EXP_RPT_EXPENSE_CHARGE (UDT08_ID) 

 EXP_AUTH_EXPENSE_CHARGE (UDT08_ID) 

If the Workers’ Compensation Code is not found in any of the preceding tables but is found in the 
CHARGE_BRANCH_CHARGE (DFLT_UDT08_ID) table, the screen displays a warning message. If you 
continue with the code deletion, the system will also delete the CHARGE_BRANCH_CHARGE records 
that include the selected Workers’ Compensation Code. 

Manage Pay Types (LDMPAYTP) 
The screen now restricts the deletion of a pay type if: 

 A Time and Expense transaction uses the pay type that you want to delete. 

 You use a system where Costpoint is co-deployed with Deltek Time and Expense. 

An error displays when you attempt to delete a pay type that also exists in any of the following tables: 

 TS_LINE (UDT10_ID) 

 EXP_RPT_EXPENSE_CHARGE (UDT10_ID) 

 EXP_AUTH_EXPENSE_CHARGE (UDT10_ID) 

If the pay type is not found in any of the preceding tables but is found in the 
CHARGE_BRANCH_CHARGE (DFLT_UDT10_ID) table, the screen displays a warning. If you continue 
with the pay type deletion, the system will also delete the CHARGE_BRANCH_CHARGE records that 
include the selected pay type. 

Updated Certified Payroll to Report Corrections 
The Federal Certified Payroll Report in Costpoint added the ability to report corrections from past pay 
periods. 

Compute Payroll (PRPCPR) 
Prior to this version, the Compute Payroll application only allowed you to compute payroll for the 
timesheets within the open pay period. You can now use the following new field on the screen to enter an 
earlier starting date for processing: 

Field Description 

Starting Timesheet Date Enter, or click Calendar Lookup, to select an earlier starting date for 
timesheet selection. 

Use this field to include corrections from past pay periods. This is 
necessary for complete certified payroll reporting, which must report 
hours worked on a particular day. 
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Print Federal Certified Payroll Report (PRRCERT) 
The application features the following changes: 

 The existing Print Certified Payroll Report screen was renamed to “Print Federal Certified Payroll 
Report.” 

 The Pay Cycle Date fields were updated to display the corresponding start/end dates when you 
enter a valid pay period starting date or ending date. 

 You can now opt to run the report for certain employees. To support this functionality, the screen 
provides the following field in the Selection Ranges group box: 

Field Description 

All Employees Select this check box to include all employees in the report. If you 
want the report to include only certain employees, clear the check 
box to list specific employees on the Employees subtask. 

 The new Employees subtask provides the following fields: 

Field Description 

Employee Enter, or click Lookup, to select an employee to include in the report. 

Name This field displays the name of the selected employee. 

 The report now includes check number information. 

 The application now includes all timesheets (whether regular or correcting types) when it 
determines the hours worked per day. The corrections are printed in separate sections. One 
correcting section prints for each pay check. 

Print Deduction/Contribution/Fringe Report (PRRMBEN) 
The application features the following changes: 

 The Print Deduction/Benefit Report by Local screen was renamed to “Print 
Deduction/Contribution/Fringe Report.” 

 The report now includes check number information. 

 The screen provides the following Report Sort options: 

 Type / Code / Employee Name / Check Date / Check Number 

 Type / Code / Employee ID / Check Date / Check Number 

 Employee Name / Check Date / Check Number / Type / Code 

 Employee ID / Check Date / Check Number / Type / Code 

 Employee Name/ Check Date / Check Number / Type / Amount 

 Employee ID / Check Date / Check Number / Type / Amount 
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Time & Expense 

Pre-Upgrade (8.1) Diagnostics Toolkit 
A Time & Expense » Configuration » Utilities » CP/TE Diagnostics Toolkit utility was added to 
version 8.1.1 that enables System Administrators to identify and address potential data discrepancies 
after upgrading to version 8.1. 

In version 8.1, Time & Expense installations that are co-deployed with Costpoint will read directly from the 
Costpoint tables for UDTs (01-11) across all domains, and therefore, unresolved data discrepancies, such 
as when a UDT exists in one system but not in the other, may result in system errors in version 8.1. 

The utility includes 19 separate diagnostics, and where issues are identified, it can automatically resolve 
the discrepancy by setting the value in one system to that of the other, or in some cases, you may be 
required to manually update the data, such as adding or deleting a UDT. 

After you upgrade, the Costpoint values, such as for UDTs, become the default value, and the older 
values from Time & Expense are moved to archive tables. 

 
For each item you select under Type, the CP/TE Diagnostics Toolkit displays instructions specific to that 
diagnostic. The first time you use the application, you must Initialize to populate the Type drop-down list. 

 

 

Warning: Depending on the issue, failure to correct the data may cause errors due to records no 
longer being available after you upgrade to version 8.1. 
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Following the installation of version 8.1.1, do the following to run the Toolkit: 

1. Click Time & Expense » Configuration » Utilities » CP/TE Diagnostics Toolkit. 
2. On the Toolkit screen, click the Intialize button. 

This process compares the Costpoint and Time & Expense data to identify discrepancies 
between them. After the initialization process is completed, the Type drop-down list populates 
with different diagnostics where discrepancies were found. Up to 19 separate types may display. 

3. From the Type drop-down list, select the diagnostic you want to review and click Show Results. 

The Results table is populated with the data discrepancies uncovered by the diagnostic. 
Optionally, you can click Record Counts to display record results for all the separate diagnostics. 

4. Depending on the type of diagnostic you selected, one of the following options may display below 
the Results table: 

 Set CP Value to T&E Value: Select this option to change the value in Costpoint to match the 
value in Time & Expense. 

 Remove from Charge Tree: This option displays only for the diagnostic that identifies 
records that exist in the Time & Expense charge tree for UDTs 01-11 but do not exist in 
Costpoint. Select this option to remove the charges from the T&E charge tree. The charges, if 
needed, must be manually added to the appropriate application in Costpoint. 

If no options display, corrections must be made manually in the appropriate area of Time & 
Expense or Costpoint. 

The table below provides a brief description of each diagnostic that may display under Type. Refer to the 
on-screen instructions in the CP/TE Diagnostics Toolkit application for details on how to correct the data 
for each one that occurs in your system. 

Diagnostic Type Purpose 

Error - Not in Costpoint - UDT in use This identifies all records that exist in Time & 
Expense but do not exist in Costpoint. 

Error - Project required flag does not match 
– UDT in use 

This identifies all accounts where the Project 
Required setting in Time & Expense does not match 
the same setting in Costpoint. 
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Diagnostic Type Purpose 

Error - Whether for time and/or expense 
does not match - UDT in use 

This identifies all projects where the time and/or 
expense value in Time & Expense does not match 
the same value in Costpoint. 

Warning - Abbreviation does not match This identifies Project and Org records where the 
abbreviation does not match between Costpoint and 
Time & Expense. 

Warning - Account type does not match – 
UDT not in use 

This identifies accounts where the Time Collection 
Account Type value in Costpoint does not match 
Account Type in Time & Expense. 

Warning - Account type does not match - 
UDT in use 

This identifies accounts where the Time Collection 
Account Type value in Costpoint does not match the 
same setting in Time & Expense. 

Warning - Active flag does not match This identifies all records where the Active setting in 
Time & Expense does not match the same setting in 
Costpoint. 

Warning - Allow Charging flag does not 
match 

This identifies all records where the Allow Charging 
setting in Time & Expense does not match the same 
setting in Costpoint. 

Warning - Calculation does not match This identifies all Pay Type records where the 
calculation in Time & Expense does not match the 
calculation in Costpoint. 

Warning - Cost Only flag does not match This identifies all Pay Type records where the Cost 
Only setting in Time & Expense does not match the 
same setting in Costpoint. 

Warning - Costpoint company does not 
match 

This identifies all Project and MO records where the 
Costpoint company in Time & Expense does not 
match the company in Costpoint. 

Warning - Description does not match This identifies all records where the description in 
Time & Expense does not match the description in 
Costpoint. 

Warning - Factor does not match This identifies all Pay Type records where the factor 
in Time & Expense does not match the factor in 
Costpoint. 

Warning - Not in Costpoint but in Charge 
Tree 

This identifies all records that exist in the Time & 
Expense Charge Tree but do not exist in Costpoint. 

Warning - Overtime flag does not match This identifies all Pay Type records where the 
overtime setting in Time & Expense does not match 
the overtime setting in Costpoint. 
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Diagnostic Type Purpose 

Warning - Project required flag does not 
match - UDT not in use 

This identifies all account records where the Project 
Required setting in Time & Expense does not match 
the same setting in Costpoint. 

Warning - Whether for time and/or expense 
does not match - UDT not in use 

This identifies all project records where the time 
and/or expense value in Time & Expense does not 
match the same value in Costpoint. 
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Software Issues Resolved 
Accounting 

Accounts Payable » Edit Voucher Payment Status 
Defect 1521133: You encountered an error when you set the voucher Status to PAY. 

Accounts Payable » Manage Vendor History 
Defect 1512929: The value of the Rate Group field on the Exchange Rates subtask reverted to the 
default value when you updated exchange rates first, entered values in the main fields, and then saved 
the record. 

Accounts Payable » View Vendor History Inquiry 
Defect 1494882: This screen has been updated to display the Cost Amt in the Amount Paid field for 
vouchers that were paid through manual checks. 

Accounts Receivable » Manage Cash Receipts 
Defect 1497473: Costpoint displayed incorrect amounts on the View Receivables and Collections screen 
and in the Accounts Receivable History report when you did the following: 

 Entered cash receipt details 

 Manually entered the invoice number in the Invoice Line Info group box 

 Updated the rates on the Exchange Rates subtask 

 Saved and posted the cash receipt 

Fixed Assets » Compute Projected Depreciation 
Defect 1407730: The fields and labels did not display correctly when you accessed Costpoint using a 
mobile device. 

Fixed Assets » Manage Asset Master Information 
Defect 1492981: This screen was updated to change the action lock setting of the Import Data button of 
the Template Import Parameters subtask to None. 

General Ledger » Create Revaluation Entry 
Defect 1510186: Costpoint allowed you to create a revaluation entry even if there were no multicurrency 
accounts configured for your functional currency. This caused the debit and credit amounts to be out of 
balance on the Manage Journal Entries screen. 

General Ledger » Import Journal Entries 
Defect 1500401: When you imported journal entries, Costpoint was unable to retrieve period exchange 
rates when daily exchange rates were unavailable. This occurred even when the Use Period Rate check 
box was selected in the Exchange Rate Method group box of the Configure Multicurrency Settings 
screen. 
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General Ledger » Manage Journal Entries 
Defect 1528719: This screen has been updated to disable the recalculation of exchange rates for journal 
entries created through the Process Organization Changes screen. 

General Ledger » Post Journal Entries 
Defect 1508972: When you clicked Print, the Journal Entries Journal displayed no labor transaction 
records even when the journal entry you posted contains vendor labor lines. This happened when only 
the Labor check box was selected in the Print Journal For group box of the Configure General Ledger 
Settings screen. 

As a workaround, click Print/Post instead of Print. 

General Ledger » Update Tax Report Tables 
Defect 1521675: When you ran the update process, tax from standard bills were not included in the Tax 
Report Header and Tax Report Line tables. 

Admin 

System Administration » Configure User Preferences 
Defect 1327998: The "Duplicate Group Names cannot be assigned" error message was shown twice 
when you added a duplicate group name in the Configure User Preferences (UPMUSRPR) application. 

Workflow » Approval Workflow Messages 
Defect 1502412: Workflow completion and rejection emails were sent from the default message ID 
instead of the message ID assigned to the Workflow. 

Workflow » Approval Workflow Models 
Defect 1519853: You could delete an approval workflow model that still had approval cases in progress. 

Defect 1526979: When you imported an approval workflow model with the New Revision option selected 
on the Import/Export Approval Workflow Model subtask in the Approval Workflow Models (WFMAPPRL) 
application, the revision number did not increase. 

CRM & Contracts 

Activities » Manage Activities 
Defect 1485846: A "No matching value" error message displayed when you tried to save a record even if 
there is valid data in the Resource ID or Task Owner ID field. This defect occurs when the Allow Offline 
Access check box is selected on the Configure System Settings screen. The issue also exists when you 
copy values on the Resources and Tasks subtasks and then update these values. 

As a workaround, you can update the value in the Business ID and Resources ID fields on the 
Resources subtask, or the Business ID and Task Owner ID fields on the Tasks subtask. 

Defect 1501149: Costpoint did not automatically capitalize the IDs you manually entered in the following 
fields, which resulted in an error when you tried to save the record: 

 Opportunity ID (main screen) 
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 Contract ID (main screen) 

 Subcontract ID (main screen) 

 Business ID (Resources subtask) 

 Resource ID (Resources subtask) 

 Business ID (Tasks subtask) 

 Task Owner ID (Tasks subtask) 

As a workaround, you can use lookup to select the desired IDs, or use the suggested values as you enter 
IDs in these fields. 

Contract Management Controls » Manage FAR Library 
Defect 1520956: When importing a FAR/Supplemental Regulation .csv file, an error occurred due to the 
title (FAR_TITLE or DFAR_TITLE) having special characters and the description (FAR_DESC or 
DFAR_DESC) exceeding 4,000 characters. 

As a workaround, remove special characters from the title and shorten the description to 4,000 characters 
before importing the file. 

Affected Applications Defect No. 

Manage Supplemental Regulations Library 1520959 

Manage Contracts 1520998 

Manage Subcontracts 1521000 

Contract Management Controls » Manage Opportunity Stages 
Defect 1506087: An error occurred when you used a stage code with a space on the GovWin IQ Mapped 
Stages subtask. 

As a workaround, use a stage code without a space when mapping it on that subtask. 

Defect 1506161: Costpoint did not allow you to delete a stage code that has records on the GovWin IQ 
Mapped Stages subtask. 

As a workaround, you can manually delete the records on the subtask before deleting the main stage 
code record. 

Contracts » Manage Contracts 
Defect 1502454: Due to a bad sender address syntax in the workflow, a system error occurred when the 
final step of the workflow was executed on the Manage Contracts screen (either Approve or Reject). 

Contracts » Manage Subcontracts 
Defect 1507314: Purchase order (PO) lines can have a period of performance (POP) that is different from 
that of the subcontract. Multiple POs linked to a single subcontract record can also have different POPs. 

Previously, POP fields on the Manage Purchase Orders and Manage Purchase Requisitions screens 
were read-only and displayed POP dates from Manage Subcontracts by default. Now, those fields will still 
default from Manage Subcontracts for new PO/PR records, but you will be able to edit them. 
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 Manage Purchase Orders screen 

 Period of Performance Starting (Other Defaults tab) 

 Period of Performance Start Date (Purchase Order Lines » Line tab) 

 Period of Performance Ending (Other Defaults tab) 

 Period of Performance End Date (Purchase Order Lines » Line tab) 

 Manage Purchase Requisitions screen 

 Period of Performance Start Date (Requisition Lines » Other Information tab) 

 Period of Performance End Date (Requisition Lines » Other Information tab) 

In PO/PR records, if the POP start or end date is outside the subcontract's start or end POP range, 
Costpoint displays a warning message. If you change the subcontract ID linked to the PO/PR record, 
Costpoint refreshes the POP information in the PO/PR record. 

Opportunities » Manage Opportunities 
Defect 1498338: GovWin IQ has changed the way it captures Cybersecurity Maturity Model Certification 
(CMMC) information. Instead of using CMMC levels 1-5, it now has a CMMC Requirements field that 
allows up to 400 characters. 

In line with this change, the CMMC Level drop-down list on the Status tab of Manage Opportunities has 
been replaced with the CMMC Requirements field, which also allows up to 400 characters. For manually 
created opportunity records, you can enter here CMMC information related to the opportunity. For 
opportunity records imported from GovWin IQ, this field displays information from GovWin IQ, but you can 
still edit it. 

Any previous information you had on the CMMC Level drop-down list will be migrated to the new field 
when you install the Costpoint 8.1.1 MR. 

Defect 1529375: When you used web services to create an opportunity, the opportunity was created but 
no value was saved in the ORG_ID column in the OPP_MASTER table. This occurred when there was 
more than one entry in the BUSINESS_UNIT_ORG table for the same business unit code. 

Framework 

External Tools » CONFIG 
Defect 1494850: The Configuration Utility did not validate characters in database names and database 
usernames for databases used for Costpoint. 

The system should have implemented the following validations, which were already being enforced by the 
Application and Database Tier installers: 

 User Name, Service Name/Database Name 

 Lowercase letters are not allowed. 

 These special characters are not allowed: ` ~!@&%^*()+={}[]|\:;"'<>,?/#.- 

 The first letter must be a character and not a number or a special character. 

 There is one exception for Oracle Service Name, where period (.) is allowed. 

 User Passwords 

 These special characters are not allowed: ! @%*{}[]|\:;"'<>?/ 
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Defect 1500399: The Integration Owner value on the Cobra tab was overwritten when you saved 
changes in the Configuration Utility. As a workaround, you can manually set the Integration Owner value 
in enterprise.properties. 

External Tools » XTDESIGNER 
Defect 1490018: The formula checker in Extensibility Designer did not work when you tested conditional 
execution formulas for result set (RS) extensibility plug-ins. 

Framework 
Defect 827221: The "Record duplicated." dialog box did not display on the application screen when you 
copied a record. 

Defect 1096841: The text for the A/P Voucher No and A/P Voucher Invoice No labels wrapped 
incorrectly in Table View on the Transactions subtask in the View Standard Billing History (BLQSTDHS) 
application. 

Defect 1116921: In the Manage Accounts Payable Vouchers (APMVCHR) application, the blue tab 
header exceeded the borders when Auto Positioning was turned off. 

Defect 1152679: The Labels for Standard Bills group box truncated the Consolidated Standard/Retro 
Billing Options group box when Auto Position was set to ON in the Configure Billing Settings 
(BLMSETNG) application. 

Defect 1346674: When you viewed timesheets in Portrait mode in Manage Timesheets (LDMTIME) or 
Manage/Approve Timesheets (TMMTIMESHEET_APPROVE) and rotated to Landscape mode, the 
screen width did not set correctly, and the edge of the timesheet did not display. You could not scroll the 
page to view the timesheet. This issue occurred on an iPhone XR, XS, or 11 PRO Max. As a workaround, 
you can refresh the page. 

Defect 1394396: When you were in applications on a smartphone, group box labels disappeared when 
you navigated between subtasks and header records. 

Defect 1415213: On a mobile device, the wrapped subtask title did not fit on the menu bar in Portrait 
mode. 

Defect 1417789: On various screens, group box fields disappeared after you rotated a mobile device 
between Portrait and Landscape mode. 

Defect 1432142: When you cloned a record in List View in the Manage Opportunities (CTMOPP) 
application on a mobile device, Costpoint did not open the cloned record in Form View. You had to find 
the cloned record and select Form. 

Defect 1435754: In the Alternative Mobile View, labels and data fields were misaligned and truncated 
when labels were set to the maximum value for RFP Dates and Labels in the Configure Opportunity 
Settings (CTMOPSET) application. This issue occurred in the following: 

 Key Milestones on the RFP Info tab 

 Additional Details on the Details/Addresses tab 

Defect 1457555: You could not view or download documents that were attached to records in Costpoint 
on mobile devices. As a workaround, you can view and download the documents in Costpoint on a 
desktop computer. 

Defect 1470156: The Make Available Offline and Voice icons were unaligned on the Application 
Toolbar. 

Defect 1477175: There was no indication of the changes made from Offline mode when you reviewed the 
updates online. Also, the Save button was disabled. 
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Defect 1486117: A critical system error might have occurred under the following scenarios: 

 You clicked the Queried Records Information – Horizontal Layout option in the File » Preview 
Default Report menu and a project that had more than 41 records was returned. As a 
workaround, you can use the Print Project Master Report (PJRBASIC) or Print Project Setup 
Report (PJRSETUP) application. 

 You exported a project to Excel. 

Defect 1498556: Long text was truncated in the More swipe feature in List View on a mobile device. 

Defect 1498651: When you made records in an application available offline, succeeding applications 
were also accessible in Offline mode, even though they did not have any offline records. 

Defect 1499013: On a mobile device, some apps that showed two screens side-by-side did not display 
the next page arrow for the Saved Queries tab in the List View screen orientation. 

Defect 1499679: The Count, Save Query, and Reset buttons did not display correctly in the Manage 
Contracts (CTMCNTR) application. 

Defect 1501008: On mobile devices, the calendar was retained after switching the Query from 
Landscape to Portrait view. 

Defect 1501013: Options that you selected in a drop-down list were highlighted twice in Costpoint on 
smartphones and tablets. The option chosen last was what the system honored.  

Defect 1502976: The History of Approval for workflow approvals did not display in full screen on a tablet. 
As a workaround, you can set the Smartphone mode to Y. 

Defect 1503900: Different paths that were generated for workflow cookies caused an issue when you 
opened a Requisition from an email approval link. 

Defect 1505037: The email icon was still visible even if you already cleared the email address with an 
incorrect format entered in the Email field. 

Defect 1505691: Copied values were cleared when you saved the record on mobile devices. As a 
workaround, you can select the record in Form view and click New » Copy Record. 

Defect 1505862: In Time and Expense, when you clicked Create User Account in Resource Information, 
the Seat for Time assignment cleared on the Access subtask. 

Defect 1507972: On a mobile device, border issues occurred on the Opportunity Assessment Details 
subtask of the Manage Opportunities (CTMOPP) application when the maximum character value for the 
Rating Description fields was 250. 

 When you tapped the Rating Description field, it expanded and a blue dashed border displayed 
around the field. 

 When you tapped any screen field, the Rating Description field reverted back to the normal size 
but without a visible border. 

As a workaround, you can switch to Portrait mode. 

Defect 1508543: On a mobile device, the Next button (>>) on a tab disappeared when Lookup was 
switched from Landscape to Portrait mode. 

Defect 1508669: The Accounts and Organizations windows should have displayed instead of the 
Selected Accounts/Organizations table window when you initially opened the Mass Link 
Accounts/Organizations (GLMLOA) application on a mobile device. 

Defect 1510595: My Menu did not close automatically when you selected the Business Intelligence 
(ERCOGNOS) application. You had to click My Menu (star icon) on the Navigation Toolbar to close the 
window. 
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Defect 1511139: Result set links displayed on some wizard tabs in Employee Self Service Wizard 
applications, like the Benefits Enrollment (ESMBENENROLL) application. 

Defect 1513840: The error message that displayed when calling the cprestfulws/cpwwsgenericimport.cps 
API needed improvement. 

Defect 1518948: You could delete multiple records at a time when they were in process in the approval 
workflow. 

Defect 1525813: In the Home Dashboard (DBDHM) application, the headers in the Manage Dashparts 
window doubled when the window size was reduced enough where you had to scroll to view the rest of 
the screen. Scrolling caused a second static header to display on the screen. 

Defect 1525871: When you used Costpoint with the Chrome browser and tried to paste data from Excel, 
an unknown message displayed on the screen. 

Runtime » Client 
Defect 1150622: Issues occurred when you used the Apply two column layout feature, such as: 

 Overlapping labels and text boxes 

 Overlapping labels and check boxes 

 Overlapping group boxes 

 Misaligned text 

 Truncated text 

 Overlapping labels in group boxes 

Defect 1422194: Costpoint needed to show saved queries as tabs for the Lookup function on mobile 
devices. 

Defect 1508772: Some applications displayed the message "Processing complete." instead of "Process 
complete." after an action. 

Defect 1517040: On mobile devices, the Voice interaction feature turned on when you opened an app, 
even though the feature was disabled in Costpoint. 

Materials 

Bills of Material » Manage Engineering Bills of Material 
Defect 1480533: When you logged into Costpoint in Offline Mode, the subtasks were unavailable and the 
New/Copy/Delete functions were disabled from the application. This issue also affected other 
applications. 

Affected Applications Defect No. 

Manage Manufacturing Bills of Material 1483152 

Approve Purchase Requisitions 1477661 

Engineering Change Notices » Manage Engineering Change Notices 
Defect 1483154: When you logged into Costpoint in Offline Mode, the New/Copy/Delete functions were 
disabled from the application. This issue also affected other applications. 
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Affected Applications Defect No. 

Enter Miscellaneous Inventory Receipts 1477234 

Enter Issues to Project/Account/Org or PO 1477657 

Manage Routings 1484262 

Manage Invoices 1483155 

Enter Inventory Transfers 1477679 

Enter Quantity Adjustments 1477281 

Manage Sales Order Inventory Issues 1483167 

Enter Manufacturing Order Issues 1483156 

Enter Manufacturing Order Reliefs 1483157 

Manage Parts 1477249 

Manage Purchase Orders 1483158 

Manage Quality Control Inspections 1483159 

Manage Purchase Order Receipts 1483160 

Defect 1506911: When you created an engineering change notice (ECN) with the same part from another 
company, you encountered an error. This happened even though the Separate Items By Company 
check box was selected on the Configure Product Definition Settings screen. 

Inventory » Create Physical Count Adjustments 
Defect 1500541: When you tried to create physical count adjustments, you encountered an error. 

Inventory » Enter Inventory Transfers 
Defect 1501511: When you reversed a transfer through the Web Integration Console (WIC), you 
encountered an error stating that the Reversing Serial/Lot Quantity may not be greater than the original 
Serial/Lot quantity. 

Inventory » Enter Issues to Project/Account/Org or PO 
Defect 1516402: You were able to issue the same serial ID when users were logged into the application 
at the same time, issued the same part ID, and selected the same serial ID. 

Inventory » Enter Miscellaneous Inventory Receipts 
Defect 1477347: When you added a record with multiple rows while in Offline Mode and you logged back 
in to Online Mode, and then you accessed, modified, and saved the added record, the application 
displayed only one record when you switched back to Offline Mode. 
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Inventory » Enter Quantity Adjustments 
Defect 1477318: When you added a record with multiple rows while in Offline Mode and you logged back 
in to Online Mode, and then you accessed, modified, and saved the added record, the application 
displayed only one record when you switched back to Offline Mode. 

Defect 1486154: When you reversed a transaction to put a part back into stock, you encountered an error 
message stating that the reversing quantity cannot be greater than the original quantity even though the 
quantities are the same. 

Inventory » Enter Scrap Adjustments 
Defect 1486153: When you reversed a transaction to put a part back into stock, you encountered an error 
message stating that the reversing quantity cannot be greater than the original quantity even though the 
quantities are the same. 

Inventory » Import Inventory Transactions 
Defect 1498116: When you used lower case for the S_INVT_TRN_TYPE instead of upper case, and you 
processed the import file, Costpoint did not display an error message even though one of the records was 
not successfully imported. 

Inventory » Manage Actual Counts 
Defect 1520624: When you entered the actual count quantity, the Counted By ID was overridden by the 
logged-in user's ID. 

Inventory » Manage Serial/Lot Information 
Defect 1500893: When you tried to delete the serial/lot location details from the screen after tracking 
switches have been turned off, you encountered a system error. 

Inventory » Print Inventory Reorder Report 
Defect 1519344: When you ran the inventory reorder report and you had no home organization, and 
Organization Security had not been applied to the Procurement Planning module on the 
Activate/Inactivate Organization Security by Module screen, you encountered an error. 

Inventory » Print Physical Count Sheets 
Defect 1491574: When you entered a Count ID and the Option was set to One, the associated Cycle 
Count Schedule populated the End field instead of the Start field. 

Inventory » View Part Inventory 
Defect 1484897: The Make/Buy check box was not updated for the new part, which resulted in incorrect 
inventory information. 

Material Requirements Planning » Manage MRP Action Messages 
Defect 1483161: When you logged into Cospoint in Offline Mode, the subtasks did not display on the 
screen. 
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Procurement Planning » Apply PO Info to Purchase Requisitions 
Defect 1500998: When you updated the requisition line commodity code and the buyer setting was set to 
Manual, Costpoint also updated the Buyer ID. 

Defect 1507320: You can now edit the requisition line Period of Performance (POP) Start Date and End 
Date even when a subcontract ID is referenced in the requisition. If the POP start or end date is outside 
the subcontract record's start or end POP range, Costpoint displays a warning message. If you change 
the subcontract ID linked to the record, Costpoint refreshes the POP information in the record. 

Procurement Planning » Manage Purchase Order Header Information 
Defect 1507323: You can now edit the requisition line Period of Performance (POP) Start Date and End 
Date even when a subcontract ID is referenced in the requisition. If the POP start or end date is outside 
the subcontract record's start or end POP range, Costpoint displays a warning message. If you change 
the subcontract ID linked to the record, Costpoint refreshes the POP information in the record. 

Procurement Planning » Manage Purchase Requisitions 
Defect 1504090: When you resubmitted rejected lines for a requisition with line text associated to it, you 
encountered an error. 

Defect 1507317: You can now edit the requisition line Period of Performance (POP) Start Date and End 
Date even when a subcontract ID is referenced in the requisition. If the POP start or end date is outside 
the subcontract record's start or end POP range, Costpoint displays a warning message. If you change 
the subcontract ID linked to the record, Costpoint refreshes the POP information in the record. 

Procurement Planning » Manage Request for Quotes by Vendor 
Defect 1481661: Costpoint allowed consolidating of requisitions for non-inventory items (goods, services, 
or miscellaneous) on a request for quote. 

Procurement Planning » Manage Vendor Quotes by Vendor 
Defect 1507943: When you created a quote from a request for quote (RFQ) where RFQ line 1 had a 
delivery schedule and RFQ line 2 did not have a delivery schedule, you encountered a system error. 

Product Definition » Import Items 
Defect 1522416: You were unable to import an update to the ABC classification. This happened even 
though the Separate Items By Company check box was selected on the Configure Product Definition 
Settings screen. 

Product Definition » Manage Parts 
Defect 1496592: The value of the Comments field was cloned into the new part. 

Production Control » Enter Manufacturing Order Issues 
Defect 1528414: In the Web Integration Console (WIC), you were unable to reverse a transaction that 
had a space in the serial number. 

Production Control » Enter Manufacturing Order Reliefs 
Defect 1504093: You were able to reverse the manufacturing order (MO) relief after the lot number was 
moved to a new location. Costpoint validated the action based on quantity, but not on lot number. 
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Defect 1509921: You were unable to save a full relief when the Use Estimate to Complete % for 
Remaining Quantities check box on the Configure Manufacturing Order Costing Options screen was 
selected. 

Production Control » Manage Manufacturing Orders 
Defect 1494208: When you changed the As of date, the parts you manually added to the manufacturing 
order (MO) requirements were not added when you saved it. 

Defect 1516398: When organization security was set and you (the planner) have access to the Inventory 
Project Organization, and you tried to move a government furnished equipment (GFE) in the 
manufacturing order (MO) requirements, you encountered an error that said the planner does not have 
access to the organization. 

Production Control » Print Manufacturing Order Documentation 
Defect 1509924: When you printed manufacturing order (MO) documents, the Print Manufacturing Order 
Documentation Update MO status was not updated to In-Shop. 

Purchasing » Create Purchase Order Change Orders 
Defect 1516970: A new Ref. Subcontract ID field has been added to the screen to display the reference 
subcontract ID from the purchase order (PO) header when you create a new change order. This new field 
allows you to add a subcontract ID for POs with activity. 

Purchasing » Import Purchase Orders 
Defect 1522415: When you created a change order for a purchase order with existing vouchers, and you 
imported an input file for it, you encountered an error. 

Purchasing » Manage Purchase Orders 
Defect 1507310: You can now edit the purchase order header and line Period of Performance (POP) 
Start Date and End Date even when a subcontract ID is referenced in the purchase order (PO). If the 
POP start or end date is outside the subcontract record's start or end POP range, Costpoint displays a 
warning message. If you change the subcontract ID linked to the PO record, Costpoint refreshes the POP 
information in the record. 

Defect 1509918: When you adjusted/updated an Open purchase order (PO), the Approval User ID was 
updated as well. 

Receiving » Manage Purchase Order Receipts 
Defect 1504102: When you deleted a receipt, Costpoint did not validate the serial number. 

Defect 1519326: When you entered multiple receipts with different exchange rates, incorrect exchange 
rates were reflected on the receipts. 

Defect 1525851: When you saved a receipt, there was an inventory discrepancy between the purchase 
order (PO) equivalent amount in US dollars (USD) and the receiving amount. 

Receiving » Manage Quality Control Inspections 
Defect 1494210: When you loaded a receipt ID, you encountered an error instead of being allowed to 
inspect receipts for PO lines with a charge type of Other. 
Defect 1504097: When you deleted a quality control receipt, Costpoint did not validate the serial number. 
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Sales Order Entry » Import Sales Orders 
Defect 1505876: The application has been updated to load the logged-in user instead of the 
application/screen name into the Modified by table. 

Sales Order Entry » Manage Sales Order Non-Inventory Issues 
Defect 1506907: When you created a new issue, Costpoint did not load the correct cost for the sales 
order unit. 

Sales Order Entry » Manage Sales Orders Supervisor Screen 
Defect 1501508: The application has been updated so that when you change the warehouse ID, the 
reservation ID for the warehouse is reflected as well. 

Defect 1513048: When you added a new line for an Inventory Part with components, clicked Save, and 
then clicked OK on the warning message, you encountered an error. 

People 

Affirmative Action » Print Training Report 
Defect 1473201: The report displayed duplicate sections of total trained and total workforce. This issue 
occurred when you used the following setup: 

 1st Sort option is Job Category/EEO Code. 

 Calculate Adverse Impacted check box is selected. 

 Include Employee Detail check box is clear. 

Defect 1500862: The report did not print when: 

 The effective date of the Salary Information record was within the training start and end dates. 

 There was no course information for the employee. 

Benefits » Create 1094-C and 1095-C Electronic File 
Defect 1514352: When you entered a calendar year, the screen populated the Middle Name and Suffix 
fields in the Transmitter Contact Information group box with a space. As a workaround, you can delete 
the spaces from the affected fields before you run the process. 

Benefits » Print 1095-Cs 
Defect 1515351: You were unable to print a 1095-C for any year prior to 2019 due to a screen validation. 

Employee » Import Employee Data 
Defect 1498998: You encountered a system error when Record 3 of the CSV file to be imported had a 
missing comma. 

Defect 1500860: Some imported employees with salary increases had negative percent of increase. 

Employee » Manage Education, Skills & Training Data 
Defect 1483573: When you used offline mode, the screen disabled the New, Copy, and Delete buttons 
on subtasks. 
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This issue also affected the following applications: 

Affected Applications Defect No. 

Manage Employee Savings Bonds 1483778 

Manage Accident Information 1483206 

Manage Deductions 1483563 

Approve Open Enrollment Elections by Plan 1483164 

Employee » Manage Employee Information 
Defect 1468290: When you cleared an employee’s work email on the Manage Employee Information 
screen, Costpoint also cleared the email of the corresponding user on the Manage Users screen. 

Employee » Manage Employee Salary Information 
Defect 1453892: The Compensation Plan field overlapped with the Review Form field label. As a 
workaround, click the Review Form field to correctly display the label for the field. 

Employee » Transfer Talent Management Data 
Defect 1466908: The application should generate a warning message when the imported employee has 
a gender of Non-Binary or X. 

Employee Self Service » Activate Pending Benefit Elections 
Defect 1464249: Costpoint deducted too much if an employee had multiple HSA elections that had 
overlapping starting and ending dates. This issue occurred when an employee had an existing HSA 
election and then added a new HSA election type through a life event. 

As a workaround, you can set the end date of the old election to a date earlier than the pay period start 
date of the open pay period. 

Employee Self Service » Benefits Enrollment 
Defect 1510298: The screen disabled the Select check boxes in the Select New Coverage table of a tab. 
This issue occurred when more than 50 records existed in the new coverage table for the system benefit 
type. 

Employee Self Service » Life Events/New Hires 
Defect 1510286: The screen disabled the Select check boxes in the Select New Coverage table of a tab. 
This issue occurred when more than 50 records existed in the new coverage table for the system benefit 
type. 

Employee Self Service » Payroll Checks 
Defect 1463149: The printed paystub did not display the company logo even if you correctly set up the 
logo file on the Configure System Settings screen. 
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Employee Self Service » Total Comp/Benefits Statement 
Defect 1480521: The labels of the Total Compensation Summary table and the Benefit Elections table 
did not display when you used the screen in portrait mode on a smartphone. 

Employee Self Service » W-2s 
Defect 1494348: The screen displayed the following message when records have the same payroll year 
and taxable entity but different tax service group IDs: “Internal environment message: Invalid rs 
ESMELECW2_FEDW2FILE_HDR metadata. Client side Primary/Logical keys should uniquely identify 
rows .Found duplicates : 2020BMW202 [screen is not open]BTE| based on keys : PR_YR_NOEMPL_ID 
[screen is not open]TAXBLE_ENTITY_ID|.” 

Defect 1494708: The label for field b should be “b - Employer's identification number (EIN)” instead of “b - 
Employer ID Number.” 

Labor » Apply Weighted Average Rates to Timesheets 
Defect 1493171: If a timesheet had only a pay type that used a weighted average method of R-
Recalculate this Pay Type, the application did not use the weighted average rate for the recalculation of 
the timesheet labor cost. 

Labor » Create Auto-Pay Timesheets 
Defect 1495335: The AUTO_ADJ_HRLY_RT column on the TS_HDR table was blank if the timesheet 
was generated through the Create Auto-Pay Timesheets screen with the Auto-Adjust check box 
selected. 

Labor » Create Retroactive Timesheet Adjustments 
Defect 1509309: When you reprocessed timesheets with previously created adjustments, the application 
created retroactive timesheets with incorrect transactional amounts. It created incorrect retroactive 
timesheets for each instance that you reprocessed the same date range. 

Labor » Export Data to Deltek Time and Expense 
Defect 1502209: The Create CSV Export Files for Base/Link Tables check box should be clear by 
default when you first open the screen. 

Defect 1515175: The application doubled the amount of leave payout lines when there was more than 
one leave type assigned to be paid out. 

Labor » Manage Correcting Timesheets 
Defect 1483881: When you used offline mode, the following issues occurred: 

 The New, Copy, and Delete buttons on the Correcting Timesheet Lines subtask were disabled. 

 Manufacturing Order Timesheet Information and Sales Order Timesheet Information subtasks 
and records did not display. 

Defect 1483889: The Org Abbrev and Transaction ID fields and their labels overlapped. 
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Labor » Manage Timesheets 
Defect 1014540: When you created a correcting timesheet, the screen displayed the following inaccurate 
message: "The Timesheet Type is 'Correcting', but no Effective Date was specified. Therefore the 
timesheet date will be used to determine the labor cost. Would you like to continue?" 

The warning message should indicate that a reference date was not specified instead of the effective 
date. 

Defect 1435341: The application should allow you to delete Salary Cap timesheets and Reversing 
timesheets. As a workaround, complete the following steps: 

1. Clone the Salary Cap timesheet. 

2. Change amounts to offset initial Salary Cap timesheets. 

3. Change the timesheet type to Correcting. 

Payroll » Compute Payroll 
Defect 1510477: The application should not generate union fringes and deductions for employees who 
are not set up as union employees on the Manage Employee Information screen. 

Payroll » Create ACH Bank File 
Defect 1511970: When you attempted to create the ACH file for multiple taxable entities, both the report 
and generated file only included the first taxable entity. 

Payroll » Create Quarterly SUTA Tax File 
Defect 1398738: The Find tab in the Query dialog box was disabled. This issue occurred when you used 
the screen in landscape mode on an Android smartphone/device. 

Defect 1493957: When you select the Enable SUTA Reciprocity Functionality check box on the 
Configure Payroll Setting screen, the application should implement the following: 

 The SUTA Taxable Wages field should display the sum of taxable amounts for the reporting 
state only. 

 The SUTA Excess Wages field should display the sum of excess wages for the reporting state 
only. 

This applies to the following states: 

 North Dakota 

 Nebraska 

 Oklahoma 

 South Dakota 

 Utah 

Defect 1493958: When you select the Enable SUTA Reciprocity Functionality check box on the 
Configure Payroll Setting screen, the application should implement the following: 

 The SUTA Taxable Wages field should display the sum of taxable amounts for the reporting 
state only 

 The SUTA Excess Wages field should display the sum of excess wages for the reporting state 
only. 



Software Issues Resolved 

Release Notes 25 

 

This applies to the following states: 

 Virginia 

 Pennsylvania 

 District of Columbia 

 Connecticut 

Defect 1503067: When you create a tax file for New Jersey, the value that you enter in the Weeks 
Worked field on the screen should be reflected in the file under Record B, position 53. As a workaround, 
you can manually update the file. 

Payroll » Delete Paychecks from Payroll Edit Table 
Defect 1498052: When you ran the Clear Paycheck Information action, the screen did not display the 
progress meter. 

Payroll » Delete Payment Advices from Payroll Edit Table 
Defect 1498053: When you ran the Clear Payment Advices Information action, the screen did not display 
the progress meter. 

Payroll » Delete Timesheet Payroll Computed Flags 
Defect 1437712: When you ran the Clear Flags action, the following message did not display when the 
process completed: "Timesheet PR Computed Flags have been cleared." 

Payroll » Export Payroll Taxes 
Defect 1499791: The calculation was incorrect for the QTD Total Hours (Field 15) and YTD Total Hours 
(Field 16) in LCEE and LCER records. 

Payroll » Manage Payroll Records 
Defect 1490501: The Accept Bank Transactions screen did not display transaction numbers for V and W 
records. This issue occurred when you performed the following actions: 

1. Void a check on the Void/Replace Posted Paychecks screen. 

2. Manually enter the advice number/check date on the Manage Payroll Records screen. 

3. Post paycheck information. 

Payroll » Print Deduction Summary Report 
Defect 1512476: The YTD deduction amount included the previous calendar year amount. 

Payroll » Print Deduction/Contribution/Fringe Report 
Defect 1518722: When a fringe code used a fringe type of Stamps, the fringe code totals on the report 
displayed the union total amount. 
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Payroll » Print Paychecks 
Defect 1508537: The combined earnings/deductions were printed in the middle of the list of 
earnings/deductions instead of on the last line. This issue occurred when earnings and deductions (or 
earnings only) exceeded the given space. 

Defect 1518765: The state tax salary amount printed on the paystub regardless of the setting on the 
Manage State Taxes screen. 

Payroll » Print Payment Advices 
Defect 1508538: The combined earnings/deductions were printed in the middle of the list of 
earnings/deductions instead of on the last line. This issue occurred when earnings and deductions (or 
earnings only) exceeded the given space. 

Defect 1526667: The state tax salary amount printed on the paystub regardless of the setting on the 
Manage State Taxes screen. 

Payroll » Update Dummy Check Numbers 
Defect 1498048: When you ran the Set Dummy Payroll Check Numbers action, the screen did not 
display the progress meter. 

Payroll » Update Tax File Country Code 
Defect 1498049: When you ran the Update Country Code action, the screen did not display the progress 
meter. 

Payroll » Void/Replace Posted Paychecks 
Defect 1514762: The Accept Bank Transactions screen did not display transaction numbers for V and W 
records. This issue occurred when you performed the following actions: 

1. Void a check on the Void/Replace Posted Paychecks screen. 

2. Manually enter the advice number/check date on the Manage Payroll Records screen. 

3. Post paycheck information. 

Team Management 
Defect 1528674: Team Management applications were not available on the menu when you were not 
licensed for Costpoint Human Resources. 

Planning 

Administration » Configuration Settings 
Defect 1506878: Because the Refresh Process was eliminated, the Configuration Settings application 
was updated with the following changes: 

 On the General tab, the Last Completed Post-Install Step will display "Steps Completed" when 
finished. 

 On the Integration tab, the following screen settings were removed: Data Reset Flag, Number of 
Days to Retrieve Data, and Number of Days to Recalculate. 
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 On the Organization tab, when the Update Employee Home Org and Update Employee 
Accrual Rate check boxes are selected, the Organization Budget Initialization Cycle application 
now updates upon opening. 

Administration » Report Table Update Process 
Defect 1507876: During refresh of the CER table, the ACT_BURDEN_DELTA routine caused 
unnecessary updates. 

Defect 1515156: The Costpoint Business Intelligence – Pending Delta routine hung when you tried to run 
it. 

Organization Budgeting » Compute Forward Rates 
Defect 1521655: Pools that had costs but no base posted to just the credit account, creating one-sided 
entries. 

Planning 
Defect 1480142: In Offline Mode, many Planning applications, especially those containing multiple 
subtasks, did not display the New, Copy, and Delete butttons. 

Defect 1480146: For many Planning applications, especially those that contain multiple subtasks, those 
subtasks did not display in Offline Mode. 

Project Budgeting » Burdened Cost Breakdown 
Defect 1511084: When the Subperiod Method field in Configuation Settings was set to Combine 
Subperiods, the year-to-date rate adjustment values in Burden Cost Breakdowns did not display as 
expected. 

Project Budgeting » Project Budgets / EACs 
Defect 1501377: The Profit % column in the Revenue Analysis table was renamed to Profit % on Cost, 
and a new column, Profit % on Revenue, was added. 

Defect 1507573: Hours-based service centers showed a doubling in EACs, while future service center 
costs were not reflected in EACs or budgets. 

Defect 1512915: The result set in Update Project Progress % included all final budgets in the database 
(in other words, multiple companies) rather than confining the results to final budgets for the company 
being viewed. 

Defect 1528177: The Percent Complete formula did not account for multiple Org IDs, causing the My 
EAC revenue to have a substantial negative in revenue adjustments. 

Resource Planning » Budget by Resource 
Defect 1523479: You were unable to edit the last period. 

Projects 

Billing » Calculate Standard Bills 
Defect 1504028: Performance tuning has been performed for Calculate Standard Bills to decrease the 
application's runtime. 
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Defect 1516409: When you calculated a bill with Wide Area Workflow (WAWF) and withholding release 
data, OTHER lines with zero values were created on the bill. 

Billing » Manage Standard Bills 
Defect 1497475: Task order number values were not printed using Print Standard Bills when any of the 
columns on the Detail subtask of Manage Standard Bills were modified. 

Billing » Print Billing Worksheet 
Defect 1507332: Costpoint was not able to print the billing worksheet when the Billing Calc Number 
(PROJ_SPPRT_SCH_NO) of a posted bill exceeded 2147483647. 

Cost and Revenue Processing » Post Revenue 
Defect 1504034: Printing on this screen was taking longer than expected when you ran it for all projects. 
As a workaround, you can run it for a range of projects instead of all projects. 

Cost and Revenue Processing » Process Organization Changes 
Defect 1505225: When you processed an organization change for a project that bills in a currency 
different from the functional currency, the organization change ignored the transactional amount. The 
transactional amount was being populated with the functional amount even if the transactional and 
functional currencies were different. 

Project Inquiry and Reporting » Print Revenue Worksheet 
Defect 1515180: Performance tuning has been performed for Print Revenue Worksheet to decrease the 
application's runtime. 

Project Inquiry and Reporting » Update Project Status Report Tables 
Defect 1506923: When you ran this application for a project that has no records in the PROJ_SUM table, 
a critical error occurred. 

Reports & Analytics 

Business Intelligence » Business Intelligence 
Defect 1508005: The net income for the Period 6 column used the Period 5 net income as reference on 
the Trended Income Statement found in Team content » General Ledger. As a workaround, use the 
legacy version of the Income Statement or the Costpoint Income Statement report. 

Defect 1509945: The PSR Report template in Planning did not reflect all rows for a project. 

Defect 1515654: The dates on the x-axis of the Opportunity Dashboard should have displayed in 
ascending order. 

Defect 1515663: The Benefits Enrollment Report in Costpoint Enterprise Reporting for HR and Payroll 
displayed data for another Organization EIN. This defect affects you if you use multi-companies. 

Dashboards » Home Dashboard 
Defect 1529559: In the Options dialog box of the My Tasks dashpart, the Functional Role field lookup 
used the View Timesheet rights to filter values available for selection. When the View Timesheet check 
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box on the Functional Roles screen in Time & Expense was not selected for the functional role code 
assigned to the user, that role code did not display in the Functional Role field lookup in My Tasks. 

Dashboards » Organization Manager Dashboard 
Defect 1510609: A system error occurred when you were navigating the Organization Manager 
Dashboard. 

Time & Expense 

Configuration » CP/TE Diagnostics Toolkit 
Defect 1522019: Informational text related to the Set T&E Value to CP Value functionality was removed. 
Accordingly, the Set T&E Value to CP Value button was hidden. 

Expense » Expense Report 
Defect 1354720: During charge lookup, attempts to use inactive projects on expense reports should have 
resulted in error messages but did not. 

Defect 1500391: Though the related expense report was voided, the expense authorization remained in a 
processed state. 

Defect 1526835: The Taxes tab did not display the tax schedule in the drop-down list when ALL was not 
one of the locations. 

Defect 1526961: After you entered a Lodging expense with the Other amount split across two rows, and 
you then saved the first row amount, that amount changed to reflect the total Other amount, while the 
second row updated to 0. 

Expense » Manage/Approve Expense Reports 
Defect 1507484: When one of two attachments on an expense report was deleted, the Attach Line View 
displayed the deleted receipt. 

Defect 1527528: When you looked up an employee on a new expense report, an error occurred. 

Time » Export Timesheets 
Defect 1502855: A supervisor was able to modify a timesheet that was in the process of being exported. 

Defect 1529250: While a timesheet was being exported, you were able to make corrections to it. 

Time » Timesheet 
Defect 1503004: When you used the start/stop summary and the UDT10 or charge required a comment, 
adding a single comment on the charge line still produced an error message stating that a comment is 
required. 

Defect 1503006: When you used Time In/Out and the UDT10 charge required a comment, adding your 
comment to the row produced an error when you clicked Save. 

Defect 1522971: When you used UDT09 abbreviations, new timesheets did not show UDT09 on 
autoloaded lines from Favorites. 
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Time » Timesheet Status 
Defect 1511089: When you ran queries for all timesheet classes with Global Full Time Exempt selected 
as a starting class, an Oracle error occurred. 
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Appendix: For Additional Information 
Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 
 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 
To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 
 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com  

http://www.deltek.com/
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